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Примеры работы
в LTspice/SwitcherCAD III

В папке My_Examples, хранящейся по адре-

су http://www.kit-e.ru/assets/My_Examples.zip,

содержатся файлы для демонстрации воз-

можностей LTspice/SwitcherCAD III.

Папка My_Project включает в себя файлы:
•• TL431.asc — схема макромодели TL431;
•• TL431_test_pulse.asc — схема тестирова-

ния TL431 в режиме компаратора;
•• TL431_test_freq.asc — схема тестирования

TL431 в режиме усилителя переменного

тока;
•• TL431_test_temp.asc — схема для темпера-

турного анализа TL431;
•• Regulator_dc.asc — схема стабилизатора

напряжения для анализа на постоянном

токе;
•• Regulator_tr.asc — схема стабилизатора на-

пряжения для расчета передаточной функ-

ции на постоянном токе;
•• Regulator_ac.asc — схема стабилизатора

напряжения для анализа устойчивости;
•• Regulator_ac1.asc — то же самое, но для по-

строения годографа Найквиста;
•• Regulator_tran.asc — схема стабилизатора

напряжения для анализа качества регули-

рования.

Файл My_Lib.lib содержит описание мак-

ромодели микросхемы TL431.

В папке My_Sym описания символов ком-

понента TL431:
•• TL431.asy — символ с атрибутом «тип ком-

понента» Cell;
•• TL431_test.asy — символ с атрибутом «тип

компонента» Block.

Чтобы воспользоваться предлагаемыми

примерами, необходимо поместить файл

My_Lib.lib в папку sub, папку My_Sym в пап-

ку sum, а папку My_Project в папку SwCADIII

установленной программы.

Модель микросхемы TL431

Файл TL431.asc — это схема макромодели

регулируемого стабилитрона TL431, создан-

ная на основе принципиальной схемы, пред-

ставленной в [2]. Эта модель, в отличие от из-

вестных SPICE-моделей микросхемы TL431,

обеспечивает удовлетворительные результа-

ты моделирования во всех вариантах приме-

нения, предлагаемых производителем мик-

росхемы. Приведем текст модели, содержа-

щийся в файле My_Lib.lib:

.subckt TL431 A C R

*TL431 Reference

*Model for LTSpiceSwCADIII, Orcad, Micro-Cap

* Designed by M.Pushkarev, Uljanovsk, Russia, 10/07/2008

Q1 N011 N011 A QN

Q2 C R N005 QN

Q3 N003 N003 R QN

Q4 N012 N011 N014 QN 2

Q5 N004 N004 N001 QP

Q6 N004 N005 N008 QN

Q7 N010 N012 A QN

Q8 N003 N004 N002 QP

Q9 N003 N013 A QN

Q10 C N003 N006 QN

Q11 C N007 A QN 3

R1 N009 N011 2.4k TC=2E-3, -2E-5

R2 N005 N009 3.28k TC=2E-3, -2E-5

R3 N009 N012 7.2k TC=2E-3, -2E-5

R4 N014 A 800 TC=1.8E-3

R5 C N001 800 TC=1.8E-3

R6 N008 N010 4k TC=2E-3, -2E-5

R7 N013 N011 1k

R8 C N002 800 TC=1.8E-3

R9 N007 N006 150

R10 N007 A 10k

D1 A N003 QD

D2 A C QD

C1 N010 N012 20p

C2 C N003 20p

.model QD D (is=10e-15)

.model QN NPN(is=5e-15 BF=120 Cje=.5p Cjc=.5p Rb=500)

.model QP LPNP(is=5e-15 BF=50Cje=.3p Cjc=1.5p Rb=250)

.backanno

.ends TL431

Описание макромодели начинается стро-

кой, включающей в себя директиву .SUBCKT,

имя макромодели и имена выводов, распо-

ложенных в порядке, аналогичном поряд-

ку размещения их в символе компонента.

Следующие три строки — комментарий,

не оказывающий влияния на моделирование.

Далее несколько строк, определяющих под-

ключение транзисторов Q1–Q11. Транзисто-

ры записаны подряд и в порядке возраста-

ния позиционных обозначений исключи-

тельно только для удобства чтения файла.

Порядок следования элементов схемы мак-

ромодели на анализ влияния не оказывает.

Для транзисторов Q4 и Q11 показано коли-

чество параллельно включенных структур,

2 и 3 соответственно. Для большинства ре-

зисторов наряду с номинальным значением

сопротивления указаны температурные ко-

эффициенты сопротивления, которыми

в основном определяется температурная за-

висимость опорного напряжения. Модели

диода и транзисторов из множества параме-

тров содержат только существенно необхо-

димые. Описание заканчивается строками

с директивами .BACKANNO и .ENDS.

В папке My_Sym есть два файла — TL431_

test.asy и TL431.asy — с описаниями симво-

лов TL431_test и TL431. Символ TL431_test,

имеющий атрибут Symbol Type — Block, ис-

пользован в проектах TL431_test_pulse.asc

и TL431_test_freq.asc, позволяющих проде-

монстрировать иерархические проекты с те-

стированием микросхемы TL431, включен-

ной в качестве компаратора и в качестве уси-

лителя.

Первый из проектов с результатами ана-

лиза показан на рис. 17 (см. КиТ № 11 `2008,

стр. 136). В левом верхнем углу рисунка —

схема тестирования регулируемого стабилитро-

на в режиме компаратора TL431_test_pulse.asc.

В правом нижнем углу собственно схема ми-

кросхемы TL431 — TL431_test.asc. В правом

верхнем углу — результаты моделирования,

где показаны графики входного напряжения

V(in) и тока коллектора транзистора Q11 ми-

кросхемы Ic(x1:Q11).

Анализ температурного дрейфа 

модели микросхемы TL431

Файл TL431_test_temp.asc после открытия

демонстрирует схему проверки поведения

компонента TL431 при изменении темпера-

туры. В этом проекте используется символ

TL431.asy, не допускающий редактирования

в составе схемы. Схема и результат модели-

рования изображены на рис. 36.

Анализ схемы стабилизатора 

напряжения на постоянном токе

Файл Regulator_dc.asc — несложная схема

стабилизатора напряжения с выходным на-

пряжением 12 В и током нагрузки до 300 мА.

Допустимый диапазон изменения входного

напряжения — 13–30 В. Схема и результат

моделирования изображены на рис. 37.

Схема стабилизатора включает в себя тран-

зисторы, модели которых отсутствуют в биб-

лиотеке standard.bjt. Один из возможных спо-

собов использования сторонних библиотек,

который и применен в данном примере, по-

местить модели компонентов на листе схемы.

Достоинство такого решения: проект запус-

кается на любом компьютере, вне зависимо-

В этой части статьи рассматриваются примеры работы в симуляторе и воз%

можные настройки программы.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008
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сти от места установки программы и нали-

чия соответствующих библиотек.

На листе схемы помещены четыре дирек-

тивы моделирования:

.dc Vin 15 30 1

.step param I list 100m 200m

.meas V(in) trig V(out)=12.022 targ V(out)=12.0225

.save V(out)

Они предусматривают анализ поведения

схемы на постоянном токе при изменении

входного напряжения в диапазоне 15–30 В

с шагом 1 В и двух значениях тока нагруз-

ки (100 и 200 мА), с измерением входного

напряжения при двух значениях выходно-

го напряжения (12,022 и 12,0225 В) и вы-

водом графика выходного напряжения

V(out) непосредственно в процессе моде-

лирования.

В окне графиков подключены два курсо-

ра: первый курсор к синему графику, соот-

ветствующему току нагрузки 100 мА, вто-

рой — к красному графику, соответствую-

щему току нагрузки 200 мА. По данным

таблички Cursor Step Information видно, что

курсор 2 подключен к графику, соответству-

ющему ступени тока 200 мА, и полученно-

му за второй проход моделирования из двух

проходов. В диалоговом окне показаны ко-

ординаты и разности координат курсоров.

На рис. 38 приведен фрагмент .log-файла,
Рис. 36. Анализ температурного дрейфа модели микросхемы TL431

Рис. 37. Анализ схемы стабилизатора напряжения на постоянном токе
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открытого по команде View>SPICE Error Log,

с результатами измерений по директиве

.MEAS.

На рис. 39 показан результат моделирова-

ния передаточной характеристики стабили-

затора по постоянному току (файл проекта

Regulator_tr.asc) по директиве:

.tr V(out) Vin.

Отчет представляет результаты вычисле-

ний коэффициента передачи, входного и вы-

ходного сопротивлений.

Анализ устойчивости 

стабилизатора напряжения

Файл Regulator_ac.asc — это схема стаби-

лизатора напряжения, подготовленная для

.AC-анализа с целью проверки устойчивос-

ти. Методика такого анализа изложена в [3, 4].

Схема и результат моделирования показаны

на рис. 40. Роль источника возмущения в це-

пи отрицательной обратной связи играет

независимый источник напряжения Vtest.

Директивами моделирования

.ac dec 100 1 10MEG

.step param C list 1p 4.7n

задан анализ с логарифмическим декадным

изменением частоты и со 100 отображаемы-

ми точками в каждой декаде в полосе частот

от 1 Гц до 10 МГц, при двух значениях кор-

ректирующей емкости С1: 1 пФ и 4,7 нФ.

Директива 

.options gmin=1E-9

обеспечивает нормальное завершение процес-

са моделирования. При значении gmin = 1E-12,

установленном по умолчанию, попытка ана-

лиза схемы при C1 = 1 пФ заканчивается со-

общением об ошибке Analysis Failed: Iteration

Limit reached.

В окне графиков изображен график –V(out)/

V(test). Результаты моделирования представ-

ляют собой логарифмические амплитудно-

частотную (ЛАЧХ) и фазочастотную (ЛФЧХ)

характеристики разомкнутой системы. Знак

«–» приводит график ЛФЧХ к виду, приня-

тому при анализе систем автоматического ре-

гулирования [5]. Запас по фазе составляет

около –22° и 41° для значений корректирую-

щей емкости 1 пФ и 4,7 нФ соответственно.

При значении корректирующей емкости, рав-

ном 1 пФ, схема неустойчива. На практике

для гарантии устойчивости рекомендуется

иметь запас по фазе не менее 30°. На рис. 41

представлен результат моделирования этой

схемы (файл проекта Regulator_ac1.asc) в ди-

апазоне частот 10 кГц – 10 МГц в виде годо-

графа Найквиста. Характеристика, соответ-

ствующая значению корректирующей емко-

сти 1 пФ, охватывает точку с координатами

(–1, j0), что свидетельствует о неустойчиво-

сти схемы.

Анализ переходного процесса 

в стабилизаторе напряжения

Качество регулирования в стабилизаторе на-

пряжения можно оценить по реакции на ска-

чок тока нагрузки. Файл Regulator_tran.asc —

это проект для анализа стабилизатора напря-

жения при скачкообразном изменении тока

нагрузки от 0 до 300 мА и обратно. Директи-

вами моделирования

.tran 0.8m

.step param C list 1n 4.7n

задан анализ переходного процесса на вре-

менном отрезке 0–1,5 мс при двух значениях

корректирующей емкости: 1 и 4,7 нФ.

Судя по графикам на рис. 42, величина кор-

ректирующей емкости сказывается не толь-

Рис. 38. Фрагмент .log)файла 

Рис. 39. Параметры передаточной характеристики по постоянному току
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ко на устойчивости схемы, но и на реакции

на скачок нагрузки. Увеличение корректиру-

ющей емкости ведет к росту амплитуды вы-

бросов, увеличивает время переходного про-

цесса и его колебательность, что ухудшает ка-

чество регулирования.

Панель настройки

Вызов панели настройки

Чтобы вызвать панель настройки, исполь-

зуется команда меню Tools>Control Panel,

в которой конфигурируются режимы рабо-

ты LTspice/SwitcherCAD III.

Сжатие (Compression)

LTspice сжимает .raw-файлы данных в про-

цессе их генерации. Сжатый файл может быть

в 50 раз меньше, чем несжатый. Сжатие вы-

полняется с потерями. Окно панели настрой-

ки (рис. 43) позволяет управлять потерями

при сжатии:
•• ASCII файлы данных (ASCII data fieles).
•• Сжатие только при анализе переходных

процессов (Only compress transient analyses).
•• Включение сжатия первого порядка (Enable

1st Order Compression).
•• Включение сжатия второго порядка (Enable

2nd Order Compression).
•• Удалив метки в обеих ячейках, можно пол-

ностью отключить сжатие данных.

Рис. 40. Анализ устойчивости по ЛАЧХ и ЛФЧХ

Рис. 41. Анализ устойчивости по годографу Найквиста
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•• Размер окна (Window Size (No. of Points)):

максимальное количество точек, которые

будут сжаты до двух граничных точек.
•• Относительная погрешность (Relative

Tolerance): относительная погрешность,

допустимая между сжатыми и несжатыми

данными.
•• Абсолютная погрешность по напряжению,

В (Absolute Voltage tolerance[V]): погреш-

ность по напряжению, обеспечиваемая ал-

горитмом сжатия.

•• Абсолютная погрешность по току, А (Abso-

lute Current tolerance[A]): погрешность по

току, обеспечиваемая алгоритмом сжатия.

Эти параметры настройки сжатия не запо-

минаются. При перезагрузке программы бу-

дут применены установки по умолчанию.

Они доступны на панели управления в диагно-

стических целях. Погрешность и размер окна

могут быть определены установкой парамет-

ров PROTELTOL, PLOTVNTOL, PLOTABSTOL

и PLOTWINSIZE в .OPTION-директивах, раз-

мещаемых как SPICE-директивы на схеме.

Операция (Operation)

Окно Operation изображено на рис. 44.

Параметры настройки, отмеченные звездоч-

кой [*], сохраняются при перезапусках про-

граммы:
•• Размещение окон по умолчанию (Default

Window Tile Pattern): размещение окон

в многооконном режиме по умолчанию

можно сделать вертикальным.
•• Вывод графиков (Marching Waveforms): ес-

ли ячейка помечена, обеспечивается отобра-

жение графиков непосредственно в процес-

се анализа по мере готовности результатов.
•• Генерация расширенного листинга (Generate

Expanded Listing): в файл SPICE Error Log

добавляется расширенный список соедине-

ний, включающий в себя список соедине-

ний использованных в схеме макромоде-

лей. Для макромоделей, описываемых би-

нарными файлами, правило не действует.
•• Открытие демонстрационных схем (Open

Demo circuits as regular schematics): с исполь-

зованием команды File>Open открываются

демонстрационные схемы .\SwCADIII\

lib\app\*.app. Видимы все SPICE-команды.

Схема может быть отредактирована и со-

хранена в новом файле. Команды с двой-

ными точками «..» показывают возможные

режимы анализа. Исполняются после ре-

дактирования SPICE-директив команды

с одной точкой.

Примечание. Каталога .\SwCADIII\lib\app

в текущей версии программы нет, возмож-

но, он присутствовал в первых версиях про-

граммы.
•• Не давать предупреждения при использо-

вании предварительных моделей (Don't

warn when using preliminary models): от-

ключение предупреждающего сообщения

для всех предварительных моделей.
•• Автоматическое удаление .raw-файлов

(Automatically delete .raw files): файлы дан-

ных графиков автоматически удаляются

после закрытия моделируемой схемы.

Это существенно уменьшает объем диско-

вого пространства, используемого LTspice,

но требует повторного запуска моделиро-

вания в следующем сеансе моделирования

данной схемы.

Рис. 42. Анализ переходного процесса

Рис. 43. Окно настройки Compression
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•• Автоматическое удаление .net-файлов

(Automatically delete .net files): после закры-

тия моделируемой схемы автоматически

удаляются .net-файлы со списком соедине-

ний. Это небольшие временные файлы, их

удаление делает папку с результатами ана-

лиза более аккуратной. Они определяют

электрические связи в схеме для симулято-

ра LTspice. Некоторые пользователи пред-

почитают не удалять эти файлы, исполь-

зуя их в дальнейшей работе.
•• Автоматическое удаление .log-файлов

(Automatically delete .log files): после за-

крытия моделируемой схемы автоматиче-

ски удаляются .log-файлы. Эти файлы со-

держат различные статистические данные

процесса моделирования, типа времени, за-

траченного на моделирование, предупреж-

дения и сообщения об ошибках, парамет-

ры шага, используемого в .STEP/.TEMP/.DC

анализах.
•• Папка для временных файлов (Directory

for Temporary Files): в ячейке показан путь

к папке для временного хранения графи-

ков и файлов обновления.

Сохранение по умолчанию (Save Defaults)

Эти настройки используются, когда не ука-

зывается, состояние каких конкретных узлов

должно быть сохранено при моделировании.

Используются настройки Save Device Currents,

Save Subcircuit Node Voltages и Save Subcircuit

Device Currents. Настройка Save Internal

Device Voltages используется только для вну-

трифирменного развития программы. Окно

Save Defauls изображено на рис. 45:
•• Сохранить токи устройств (Save Device

Currents): пометьте, чтобы отобразить то-

ки приборов и через порты. Это потребу-

ется для отображения графиков рассеива-

емой мощности.
•• Сохранить узловые потенциалы макромо-

делей (Save Subcircuit Node Voltages): от-

метьте, чтобы отобразить напряжения в ие-

рархических проектах.

•• Сохранить токи в приборах макромодели

(Save Subcircuit Device Currents): отметь-

те, чтобы отобразить токи в иерархичес-

ких проектах.
•• Не сохранять Ib(), Ie(), Is(), Ig() (Don't save

Ib(), Ie(), Is(), Ig()): при этом сохраняются

только токи коллектора (стока) транзисто-

ров для сокращения размера выходного

.data-файла. Полезно в проектах интеграль-

ных схем, но означает отсутствие множе-

ства данных, необходимых для расчета

мощности, рассеиваемой транзисторами.

Окно настройки SPICE

Это окно (рис. 46) позволяет изменять на-

стройки по умолчанию для LTspice. Эти на-

стройки могут быть отменены для конкрет-

ного проекта при задании в нем режимов.

Обычно эти настройки оставляются такими,

как есть. При частом обновлении програм-

мы можно нажать Reset to Default Values, что-

бы перезагрузиться к текущим рекомендо-

ванным настройкам.

Есть один параметр, который рекомен-

дуется изменять: TRTOL. В коммерческих

SPICE-программах он по умолчанию равен 7.

В LTspice параметр по умолчанию равен 1,

для того, чтобы при моделировании с исполь-

зованием макромоделей ИИП уменьшить ве-

роятность появления артефактов в графиках.

TRTOL в большей степени затрагивает стра-

тегию timestep, чем непосредственно влияет

на точность моделирования. Для моделиро-

вания на уровне транзисторов значение

больше 1 — обычно лучшее решение. Мож-

но заметить, что скорость удваивается, если

увеличивать TRTOL, что неблагоприятно

воздействует на точность моделирования.

Установленное значение TRTOL сохраняется

при перезапуске программы. Большинство

традиционных SPICE-параметров, определя-

ющих точность, (GMIN, ABSTOL, RELTOL,

CHGTOL, VNTOL) не сохраняется при пере-

запуске программы. Если желательно исполь-

зовать настройки, отличные от установлен-

ных по умолчанию, необходимо написать ди-

рективу .OPTION, задающую необходимые

значения, и поместить ее в схему, либо запи-

сать настройки в файле .INC.

Важно и то, какое вычислительное ядро ис-

пользовано. LTspice содержит две полных вер-

сии SPICE. Одна называется нормальной, дру-

гая — альтернативной. Альтернативное вы-

числительное ядро применяет отличающуюся

свертку разреженной матрицы с уменьшенной

ошибкой округления. Как правило, скорость

моделирования с альтернативным вычисли-

тельным ядром в два раза ниже, но в тысячу

раз лучше точность. Это полезно иметь для

диагностики. Если нет директивы .OPTION,

однозначно указывающей на используемое

ядро, следует сделать выбор прежде, чем будет

считан список соединений, поскольку два

ядра используют различные анализаторы.

Пометив ячейку “Accept 3K4 as 3.4K”, мож-

но заставить LTspice понимать число, напи-

санное в виде 4K99, как 4.99K. Обычная прак-

тика SPICE этого не позволяет, но это доступ-

но в LTspice по запросу.

Варианты списка соединений 

(Netlist Options)

Окно Netlist Options показано на рис. 47:
•• Преобразование «μ» в «u» (Convert 'μ' to 'u'):

везде «μ» заменяется на «u». Используется,

если установленная MS Windows не может

показать греческую μ (как, например, не-

которые китайские выпуски Windows по

умолчанию не имеют шрифтов), а также

для генерации списка соединений для

SPICE-симуляторов, которые не понима-

ют «μ» как метрический множитель 1e-6.
•• Изменение порядка записи компонентов

(Reverse comp. Order): обычно элементы

схемы перечисляются в списке соединений

в порядке, в котором они были добавлены

в схему. Активизация этой ячейки меняет

порядок записи на обратный.
•• Приборы по умолчанию (Default Devices):

всякий раз, когда, к примеру, в схеме LTspice

Рис. 44. Окно настройки Operation Рис. 45. Окно настройки Save Defaults Рис. 46. Окно настройки SPICE
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применяется диод, по умолчанию в список це-

пей добавляется строка модели “.model D D”,

чтобы подавить сообщения об использо-

вании модели по умолчанию. Непомечен-

ная ячейка подавляет включение аналогич-

ных строк моделей биполярных, МОП

и полевых транзисторов.
•• Библиотеки по умолчанию (Default Libraries):

всякий раз, когда, к примеру, в схеме LTspice

применяется диод, по умолчанию директи-

вой .lib в моделирование включается библи-

отека standard.dio. Непомеченная ячейка по-

давляет включение этой библиотеки, а так-

же аналогичных ссылок на библиотеки

биполярных, МОП и полевых транзисторов.
•• Проблемы конвергенции (Convergence

Aids): используется только для развития

программы.

Компилятор (Hacks)

Это окно использовалось для развития про-

граммы, но в настоящее время практически

устарело.

Обычно можно оставить имеющиеся на-

стройки. При частом обновлении програм-

мы желательно нажать Reset to Default Values

для перезагрузки с текущими рекомендован-

ными настройками.

Режимы рисования (Drafting Options)

Окно Drafting Options изображено на рис. 48:
•• Разрешение замыкать выводы компонен-

тов (Allow direct component pin shorts):

обычно можно тянуть связь прямо через

компонент, отрезок связи, закорачиваю-

щий выводы компонента, будет удален.

Если пометить ячейку, то этот отрезок не

будет автоматически удален.
•• Автоматический скроллинг при просмот-

ре (Automatically scroll the view): актива-

ция этой ячейки позволяет при просмот-

ре изменять масштаб схемы, используя ко-

лесо прокрутки мыши.
•• Разрешение показывать точки привязки

текста (Mark text Justification anchor points):

отображается маленькая окружность, ука-

зывающая точку привязки блока текста.
•• Маркировка неподключенных выводов

(Mark unconnected pins): рисуется малень-

кий квадрат на каждом неподключенном

выводе для указания на отсутствие связи.
•• Отображение на схеме точек сетки (Show

schematic grid points): делает видимой сетку.
•• Ортогональная разводка связей (Orthogonal

snap wires): обеспечивает рисование сег-

ментов электрических связей только по

вертикали или по горизонтали. Если ячей-

ка дезактивирована, связь может быть на-

рисована под любым углом между узлами

сетки. Нажатая клавиша Ctrl на время от-

меняет эту установку.
•• Ортогональный режим перемещения (Orto

drag mode): при выполнении команды Drag

компонент перемещается только вдоль ли-

нии связи, в которую он включен.
•• Добавление изломов в линии связи (Cut

angled wires during drags): при выполне-

нии команды Drag неортогональная связь

преобразуется в два сегмента, если нажать

на середину линии связи.
•• Глубина отката (Undo history size): уста-

новка размера буфера команд undo/redo.
•• Рисование толстыми линиями (Draft with

thick lines): увеличивает толщину всех ли-

ний. Полезно для подготовки изображе-

ний для публикации.
•• Отображение штампа (Show Title Block):

режим для внутреннего использования.

Работа в Интернете (Internet Options)

Это окно панели настроек (рис. 49) ис-

пользуется для обновления через Интернет.

LTspice часто обновляется с новыми возмож-

ностями и моделями. Для обновления до те-

кущей версии используется команда меню

Tools>Sync Release. Если в течение пары ме-

сяцев не производилось обновление, LTspice

начинает спрашивать, не желаете ли вы про-

верить обновления. LTspice никогда не полу-

чит доступ к сети, не спрашивая разрешения.

LTspice не содержит никаких закладок для пе-

редачи данных любого типа при получении

файлов, нуждающихся в обновлении.
•• Не делать кэш-файлов (Don't cache files):

при обновлении не делать кэш исполняе-

мых файлов.
•• Не проверять контрольные суммы (Don't

verify checksums): по соображениям безо-

пасности LTspice использует собственный

конфиденциальный 128-битовый алгоритм

контрольной суммы для подтверждения под-

линности файлов, получаемых из сети для

обновления. Эта аутентификация может не

состояться в случае, если в алгоритме есть

ошибка. Однако ни о каких проблемах с этим

никогда не сообщалось, так что не рекомен-

дуется пренебрегать этой основой безопас-

ности. Для доступа в Интернет LTspice ис-

пользует только обращение к операционной

системе высокого уровня. Нет необходимо-

сти в изменении параметров настройки, кро-

ме редких случаев, когда требуется опреде-

лить прокси-сервер и пароль, поскольку

не LTspice управляет доступом в Интернет,

а ваш компьютер и операционная система.

Параметры настройки этого окна не сохра-

няются при перезапуске программы.

Далее будут рассмотрены описания моде-

лей компонентов. ■
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